Fund Accounting Cash Receipts Release Log
Summary

Description

Upgrade Release December 9, 2020 – 1.1.10.81
Upgrade Release January 10, 2020 – 1.1.10.78
Upgrade Release December 26, 2019 – 1.1.10.75
Upgrade Release September 03, 2019 – 1.1.10.72
Upgrade Release March 5, 2019 – 1.1.10.67
CR: Receipt Reports Filers Corrected for Transaction Code Filtering
CR: Overview: Pontem on the Web: Online Training & Support Link Updated
Changed FAS CR Update Password
Upgrade Release June 11, 2018 – 1.1.10.55
User Group Rights Adjusted to View Reports
Manage Payers: Go To Payer Tool Enhancement
Upgrade Release February 26, 2018 – 1.1.10.49
Update Password Change
Upgrade Release January 23, 2018 – 1.1.10.47
Return Item Receipts corrected to allow “Enter G/L In Receipt” Transaction Codes to be used

Adjustment to the journal entry created by the bank deposit when the bank debit account + income account
are in different funds.

Correction: The CR: Reports: Receipt Reports filter has been modified to load the Transaction Code filter options in a way which does not
depend on the user's default department setting.
Correction: The “Online Training & Support” link on the CR: Overview work space has been updated to direct users to the new Pontem
Help Center.
Pontem FAS Update Passwords Changed. See update notice for new passwords
Correction: The group rights for the 'CR_PUBLIC' user group have been adjusted to allow users assigned to this group only, to be able to view all reports in CR.
The 'cr_view_reports' right needs to be combined with 'cr_print_receipts' right, to grant access to all reports.
Correction: The Go To Payer tool, on the Manage Payers work space, has been updated so the drop down list will display all Payer
Names. This allows the payer list to be refocused on any Payer in the list.

Correction: The Return Item Receipts have been corrected to allow users to enter a Transaction Code on the receipt which utilizes the
"Enter G/L Summary in receipt" option. Previously the Return Receipt would not allow the use of these Transaction Codes as it did not know how to record them.
Correction: For users with the following preference setting combination: Post To GL = Per Receipt + a Transaction Code with 'Enter G/L Summary in receipt'; the
system has been corrected to use due to & from accounts when recording the journal entry. This is needed with the Bank Acct Code debit account and the income
credit account selected in the receipt, are in different funds.

Upgrade Release May 18, 2017 – 1.1.10.39
Manage Receipts: View tab: Review All Receipts: Page Down Transition Corrected

Correction: When reviewing all receipts in the Manage Receipts Work Space, the page down transition has been corrected, so as not to skip receipts. The correct
receipts are displayed in date order then receipt number, as expected.

Upgrade Release February 16, 2017 – 1.1.10.36
Enter G/L Summary in receipt summary grid change

Correction: The grid used to enter the G/L Summary in the receipt has been replaced to address an issue with editing receipts. This feature is usually used in
miscellaneous transaction codes, and the user should not see any difference or change.

Upgrade Release December 13, 2016 – 1.1.10.29
Upgrade Release November 11, 2016 – 1.1.10.28
Journal Entry Test Added To The Save Of Receipts

Summary Code Account Number Warning Added
Create New Returned Item cash account correction when Post to GL = Per Receipt.

Enhancement: A test has been added to the receipt save process to insure receipts will generate a balanced journal entry. If a receipt is started which will create
an unbalanced journal entry inside of a fund, the save process is stopped and the user is instructed where to
look and make changes to correct the issue.
Enhancement: A warning message has been added to the Summary Code tool notifying users when the fund number of the Summary Code: Debit Account # does
not match the fund of the Transaction Code: Credit Nbr. The user is asked to change the settings for either the Summary Code or Transaction Code, and warned
receipts will not save if the settings are left as they are.
Correction: The Return Item tool has been corrected to use the cash account in the journal entry instead of the Clearing Account (Funds
To Be Deposited). This was only a problem on New Returned Items.
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Bank Reconciliation Check Status Change Correction

Correction: Correction to Bank Reconciliation process to leave the status of open checks unchanged when the reconciliation is completed
for the month.
Correction: When a Transaction Code is set to Enter G/L Summary in receipt and the Transaction Window pops up, the focus is placed on the Summary Code
and any preset default values are populated. When the user clicks on any other field, the focus is placed on the
selected field.
Correction: The list of receipts and corresponding Journal Entry on the GL Transaction tab of the Cash Management: Deposit Detail View has been corrected.
The list now reflects the correct receipts and the journal entries which go with it.

Focus fix for Enter G/L Summary in receipt tool

GL Transaction Tab: On Deposit Detail View: Receipt List Corrected
Upgrade Release December 30, 2015 – 1.1.10.8
New Warning For Inactive Bank Accounts
Upgrade Release November 03, 2015 – 1.1.9.19
Custom deposit slips can be assigned to the Print Receipt button
Bank Reconciliation optimized for better performance
Bank Reconciliation List Refresh When Items Are Voided

New warning message when changing bank account components.
Returned Items Tool, Changed The Receipt Selection Process
Receipt Date Validation Added
Edit Receipts Have New Memo Of Transaction History
Additional Account Number Test On Receipts

Join a Webex support meeting links have changed
Topic Search Help Removed From Help Menu
Add Warning Message To Copy Transaction Code Tool

Report Memo can be added to any bank reconciliation report
Upgrade Release December 26, 2014 – 1.1.8.63
Bank Reconciliation Permission Change
Duplicate Items Displaying In Bank Reconciliation
Upgrade Release November 12, 2014 – 1.1.8.56
Create new Banks and Bank Account Error Correction

Enhancement: A new warning message has been added to warn users when voiding a deposit for an inactive bank account. This is to
help prevent unintentional transactions to closed bank accounts.
Correction: From the Menu, Edit | Adjust Preferences | Reports: Assignments. This feature has been corrected to allow a customized
deposit slip report to be assigned to the Print Receipt button.
Enhancement: The Bank Reconciliation tool has been optimized to decrease the time it takes to 'Finish and Reconcile' the bank account.
Correction: When opening the Bank Reconciliation tool and selecting the option to resume a reconciliation, the list of transactions will first
refresh to include new deposits and cash adjustments as well as remove voided items.
Enhancement: A warning message has been added to the Manage Banks tool when a component of a bank GL account number has changed. The warning
instructs customers to insure all CR Summary Codes are using the correct account numbers.
Correction: To return an entire receipt, the highlighted row is used, rather than using a check box on the row.
Correction: A test has been added to insure the Receipt Date is in the current or prior fiscal year. This will alleviate confusion with
possibly having a receipt dated in CR with one date and a different date for the GL Transaction Date.
Enhancement: On receipts which are an edit of a previous receipt, a new log has been added to the Memo tab noting the Original Receipt
# and the Voiding Receipt #. This is to facilitate easier audit tracking.
Correction: Additional verification have been added to CR receipts to prevent the use of a single account number for both the debit and
credit account of a transaction. This prevents a net $0.00 journal entry.
Adjustment: The link titled Join a Webex support meeting on the Overview workspace ha been changed to "Join a Support Meeting". The link has also been added
to the 'Help' menu at the top so the link can be accessed from any workspace in the program.
Feature Change: The Topic Search has been removed from the Help Menu due to a change in the method used by Pontem Software to
deliver program help and documentation to customers.
Correction: Added an error message to the Copy Transaction Codes tool warning users of an existing active or inactive transaction code.
Correction: Many of Pontem's reports allow a memo to be added at the time it is generated. The Bank Reconciliation Report has been changed to allow the report
memo to be edited each time the report is generated when previously only the first time the report was run
could the memo be added.
Correction: Bank Reconciliation process has been adjusted to work on Cash Receipt permissions for the users, regardless of
permissions in other apps.
Correction: The Bank Reconciliation Tool has been fixed to eliminate the appearance of duplicate items in the Withdrawal grid of the
Bank Reconciliation Clear Transactions window.
Correction: When an validation message was shown that the Fund was required, the tool was causing another error to occur when saving
the record, preventing the new bank from saving.
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Adjustment to Returned Items UI

Correction: The input fields on the 'Returned Item' UI have been adjusted to ensure the amounts entered use the proper sign in the Cash
Management Workspace, Bank Reconciliation, and General Ledger.
Enhancement: To ensure amounts are recorded correctly in the 'Return Receipt Tool', the amount fields have been formatted to change
the amount to a negative amount, regardless of how the amount is typed in.
Enhancement: Report preferences can configure email settings to use Internet-based email accounts (Gmail, Yahoo) to mail reports.
Contact your organization's IT department to determine the settings you need for email to work.
New Feature: A new warning message has been added to the void deposit process to alert users of a returned receipt which was part of
the original deposit, but will not be part of the voiding journal entry.
Enhancement: A warning message has been changed in the 'Manage Banks Tool'. When more than one bank account is keeping money
for a single GL cash account, Bank Reconciliation will not be able to reconcile the GL account.
Enhancement: When UB import files are imported into CR the program will now rename the import file after the process is completed.
The new file will now be CRRCPTS.done. Only the most recently imported file is kept.

Number Format Change in Return Receipt Tool
Ability to Use Web-hosted Email Programs When Emailing Reports
New Warning Message When Voiding Deposits
Warning Message for too many bank accounts for a cash account
UB Import Files Renamed After Import
Upgrade Release April 11, 2014 - 1.1.8.34
Reconcile Transmittal UI - New Credit/EFT Input
Reports | System Table Reports | Bank Master List
New Warning Message For Setting Bank Acct Codes Inactive
Inactive Departments Still Showing In Drop Down List
Copy Transaction Code Availability

Cash Drawer Report W/ Credit Card/EFT

Enhancement: An additional field has been added to the Reconcile Transmittal Tool to enter Credit Card and EFT amounts. The resulting
report has been modified as well.
Enhancement: The Bank Master List report has been updated to display each fund's cash accounts associated with a bank account code
when 'Include Details' is selected.
Enhancement: The user will now be warned when changing the status of a Bank Acct Code to 'Inactive' if that Bank Acct Code is in use in
a Cash Receipt Summary Code and must be changed before deactivating the account.
Correction: Departments designated as Inactive no longer appear in drop down lists throughout the software.
Correction: When copying a Transaction Code from one department to another they were not available for use without closing the
program. Drop down lists now refresh with the newly created transactions codes.
New Report: The Cash Drawer Report w/ Credit Cards/EFT has been added to the 'Receipts Reports' category per customer request. This report includes credit
card receipt totals in addition to cash and check receipt totals - listed by receipt date.

Upgrade Release February 12, 2014 - 1.1.8.26
Bank Deposit Slip

Refinement: The Bank Deposit Slip has been improved to adjust for checks written for greater than the amount due on the receipt. The total of the check is listed
on the deposit slip and the amount of cash deposited is reduced by the change returned. If there is no cash to
deposit after the adjustment the cash amount is set to zero.

Upgrade Release December 20, 2013 - 1.1.8.15

Voiding Deposits With Receipts In Multiple Banks

Void Protection Of Receipts Included In A Deposit or Transmittal
Upgrade Release November 07, 2013 - 1.1.7.42
CR Admin Rights Not Carrying Over To GL
Cash Transfer Tool Using Correct Sub Accounts
Upgrade Release July 20, 2013 - 1.1.7.22
Voided Receipts Notes include the reversing receipt #

Correction: The Void Deposit program has been enhanced to detect if, in the deposit being voided, there exists a receipt, or receipts, with money deposited in two
or more bank accounts (therefore other deposits). There is a warning when this condition exists allowing the user to decide if ALL the deposits involved with those
receipts will be voided. The user may choose to Cancel and deal with the receipt they wanted to correct or remove from the deposit with the Cash Adjustment tool
for Returned Items.
Enhancement: Additional rules have been added to protect receipts from being voided when they are included in a deposit or transmittal.

Correction: Adjusted General Ledger rights to grant users assigned to the CR Admin group with the right to make GL Journal Entries
without specific GL group rights assigned to them in the Pontem GL software.
Correction: The Cash Transfer Tool was using the wrong field for the sub-account when a ledger account number was entered. This
caused an incorrect error message.
Enhancement: When a receipt is voided, an entry is made on the Notes Tab recording who voided the receipt and the number for the
reversing receipt.
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Warning Message Grid in Preferences

Enhancement: Edit | Adjust Preferences | User Config | Reset Warnings has a new grid presentation for easier management of resetting
error messages.

Upgrade Release March 13, 2013 - 1.1.6.12
Cash Management Report
Cash Receipt From Listing Checks
Change in storage of User Preferences
Upgrade Release January 16, 2013 - 1.1.5.18
Upgrade Release December 18, 2012 - 1.1.5.9
New School Account Filters for Board/Council and Budget group Reports

Enhancement: The Cash Management Report displays the user who created the deposit as well as the user who entered/edited the
receipt if in detail mode.
Enhancement: The printed customer receipt did not list checks appropriately if there where too many to fit on one page. The form has
been modified to continue listing checks on a second page when there is not enough room on the first.
Enhancement: User Options in Cash Receipts are now stored in the metadata to retain current User Defaults after and update.

Sorting the Cash Management Report

New Feature: Schools can now filter most of the reports in the Board/Council group and the Budget group by the
Additional Account Information (Suffix Code, Program, Grant Code, Facility, & Other). These filters are located on the "Additional" Tab on the Report Filter pop up
window.
New Report: A new report for schools is located in the Chart of Accounts Maintenance group called "Chart of Accounts with Additional Details" This report displays
the account number breakdown with additional account number fields related to the school ledger account
structure.
Enhancement: The Cash Management Report can now be ordered by Date or Bank Account as requested by customers.

Deposit Slips

Enhancement: A check box for 'Print Deposit Slip' is found in the Process Deposits 'Confirm Process Deposits' view. When selected this option will step the user
through printing a deposit slip for each bank account found in the processing.

Chart of Accounts with Additional Details Report

Transaction Codes Report
Pay Voucher Quick Search

Bank Deposit Report
Upgrade Release October 15, 2012 - 1.1.4.19
Printing non-default payment receipts

Enhancement: The Transaction Codes Report now displays the information in alphabetical order by Department, then by Transaction
Code.
Correction: The Quick Search result will display any vouchers meeting the search criteria in the list view. If a new voucher is created, it will also display in the list,
even if it does not meet the criteria. This is to give the user the opportunity to view and edit the voucher if needed. If the Search button is clicked, the filter is run
again, and only vouchers meeting the criteria will once again be displayed.
Correction: It was brought to our attention the filter for this report was not working correctly when running the Bank Deposit Report for a transmitted and deposited
receipt. The report filter has been corrected and now returns appropriate results.

Correction: When prompted to print a receipt with a payment method other than the default, the program could not find the receipt. This
problem has been corrected and the receipts are generating properly regardless of payment method.

Upgrade Release September 18, 2012 - 1.1.4.13
Copy Transaction Codes

Bank Reconciliation Accounts
Manage Receipts Tools
Upgrade Release July 13, 2012 - 1.1.3.10

New Feature: A new tool to copy Transaction Codes from one department to another saves time for the user as they do not have to recreate already existing
transaction codes in another department. Users can copy one or multiple transaction codes at the same time.
Corrections: When reconciling the bank account used for payroll, the Bank Rec Tool would pull the GL account balance
for only the payroll fund, regardless of other funds associated with the bank account. The tool has been adjusted to include all GL accounts associated with a bank
account when comparing ending balances.
Correction: The Tools tab for the Manage Receipts Workspace is now correctly linked for each tool on the tab. Previously the Quick
Codes link took users to the Departments tool. This has been corrected.
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Manage Banks

Enhancement: If a bank account record in Manage Banks has no fund(s) assigned and the user is attempting to perform a Cash Adjustment or Transfer using it, an
option has been included to allow the Fund Code to be added to the bank account record on the fly.

Cash Transfer Tool Development
Quick Codes

Bank Reconciliation Report
Process Deposits Quick Search

Utility Billing Import Transaction Code Validation
Utility Billing Import
Creating Transaction Codes
Edit Receipt Check Payments
Reports | Process Deposits | Bank Deposit Report
Upgrade Release March 23, 2012 - 1.1.2.163
Bank Rec User Permissions
Reports | Cash Management | Cash Management Report
Deposit Void Dates

Enhancement: Cash Transfer Tool has been changed to properly display the transaction in the Cash Transfer Window. The G/L transaction for a Cash Transfer
will always use the 'due to' and 'due from' between funds. A warning will pop up if the transfer causes the
bank account to have a negative balance.
Correction: Quick Codes have been modified so Transactions Codes included in the Quick Code are no longer included on the receipt if
they are made inactive.
Enhancement: Users have requested a total for the cash accounts included in the bank reconciliation to be included at the bottom of the list. The total has been
added and the heading of "Out of Balance" has been changed to more accurately reflect "Bank Reconciliation
Adjustments."
Modification: The Quick Search fields in the Process Deposits workspace have been modified to work with Transmittal to include or
exclude them in deposits based on the field inputs.
Enhancement: The Utility Billing Transaction Code Validation Procedure now checks for Transaction Codes with a Calculation Type of "None" be for it will allow
data to be imported using the specified code. This is designed to avoid predetermined calculation rates to
override the actual amount collected in the UB system.
Feature Request: The Total Amount Imported has been added to the confirmation window of the import process to allow verification with
reports from UB.
Enhancements: When entering new or editing Transaction Codes, the system checks for assigned Summary Codes or the option to
Enter G/L Summary in receipt.
Correction: The multiple check payment tool in the receipt will now allow the conversion of a payment from check to cash after a receipt
was saved.
New Feature: When the Bank Deposit Report is run to show details, the receipts for each deposit are listed directly
under the deposit instead of grouped together at the end of the report.
Correction: Users now only require bank rec permissions in CR, and no longer require access to AP or PR.
Correction: The user name displayed with each receipt record now reflects the creator of the receipt, not the depositor.
Enhancement: Voiding deposits now allows the user to specify the General Ledger Transaction Date the void needs to
be entered on. This allows the void to happen on the date of the deposit instead of the current date.

Upgrade Release December 20, 2011 - 1.1.2.139
Transmittal Process Update
Manage Receipts | New Receipt
Upgrade Release September 29, 2011 - 1.1.2.113
Manage Transaction Codes | Tools | Quick Codes
Descending Sorts on List Views
Reports | Receipt Reports | Cash Drawer Reports
Reports | Receipt Reports | Daily Receipt Reports
Cash Management | Bank Reconciliation
Cash Management | Bank Reconciliation | GL Tab | Include Sub
Accounts
Manage Receipts | Print receipt on save
Reports | System Table Reports
Cash Receipts | Reports Menu

New Feature: The process for creating and receiving transmittal's has been implemented to allow for multiple departments using Pontem CR to post receipts and
provide a transmittal to the department the does the bank deposits. There are new reports included to support
this process.
Correction: When entering a transaction code using the G/L Summary tool, a test is now run on a line by line basis to test if debit and
credit accounts are from the same fund.
New Implementation: Implemented Quick Code Tool.
Enhancement: Made changes to the list views so that if you click on the column heading, it sorts in descending order.
New Implementation: Implemented Cash Drawer Report. Changed order to print in Date | Receipt number order.
New Implementation: Added the ability to filter by Transaction code for the Receipt Reports.
New Implementation: Cash box and credit card deposits will now show in bank reconciliation.
New Implementation: Added new check box on the g/l page of bank rec. "Include accounts with different sub-accounts".
Correction: Made changes so you can now print a receipt for a different payment type than the default.
New Implementation: Implemented new reason code list report.
New Implementation: Made changes to the report tree/menu to include new folders and reorder reports.
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Manage Receipts | Default Receipt Date Preference

New Implementation: Implemented new preference in system configuration to define how the receipt and transaction date default.

Reports | Receipt Reports | Voided/Edited/Receipt Report
Cash Management | Bank Reconciliation | Change Starting
Balance
Reports| Receipt Forms| Deposit Slip
Reports | Receipt Reports | Returned Receipt Report
Print Receipt
Manage Receipts | Tab Order

New Implementation: Implemented new Voided/Edited/Receipt Report.
New Implementation: Will now allow the client to edit the starting balance as long as a bank reconciliation has never been finished.

Edit | Adjust Preferences | System Config | General | Clearing
Account
Manage Receipts | Payer Name, Address, and Quick Code drop downs
Cash Management | Tools | Manage Banks | Warning for duplicate account info

New Implementation: Implemented new Deposit Slip report.
New Implementation: Implemented new Returned Receipt Report.
Correction: Made changes to fix the truncated Payer name city, state, and zip on receipt.
Correction: Made changes to correct the Manage Receipts tab order, Implemented keyboard shortcut keys for transaction and quick
codes.
Correction: Made changes to enable the clearing account field if the user is posting to the general ledger per receipt.

Manage Receipts | Edit Receipt

Correction: Made changes to narrow the drop down fields to display properly.
New Implementation: Made changes so if a bank account has the same accounting information as another bank account, you will get a
warning that the bank accounts will not be able to reconcile with G/L.
Correction: Made changes so that after processing deposits, when configured for post-per-receipt, the g/l transaction will now show in
the cash management record's g/l tab.
New Implementation: Made changes so when editing an existing receipt that has check numbers and check amounts you will get a warning message will display to
remind the client to also edit the check number details if the amounts on the receipt are changed.

User Rights

Correction: Made changes so that you cannot click on Bank Reconciliation if you do not have rights to it.

Manage Receipts | Post per receipt | No consolidation

